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PODSTAWY MATHCADA

1. Interfejs graficzny programu
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Interfejs uzytkownika programu Mathcad

Interfejs uzytkownika programu Mathcad ma tg sama strukturg co inne programy pracujace
w systemie Windows. Sktada si¢ na niego:

- pasek menu,

- pasek narzedzi standardowych,

- pasek narzedzi formatujacych,

- pasek operatorow matematycznych,

- obszar roboczy,

- pasek stanu.

1.1. Pasek menu

Pasek menu sktada sig z grup polecen:

| File Edit Wiew Insert Format Tools  Symbolics  Window  Help

Po wskazaniu wybranej grupy polecen uzyskuje si¢ dostgp do podmenu; trzy kropki przy poleceniu
oznaczaja, ze po wskazaniu ich pojawi si¢ okno dialogowe, w ktérym dokonuje si¢ wymaganych ustawien.
Grupy File, Edit, View, Windows i Help zawierajq polecenia znane z innych programéw pracujacych pod
kontrola systemu Windows; pozostate: Insert, Format, Tools i Symbolics zawieraja, oprécz standardowych
polecenia stuzace do wprowadzania, formatowania i przeprowadzania obliczen w dokumentach Mathcada.



Przyktadawe rozwinigcie grupy polecen Symbolics
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umozliwia przeprowadzanie obliczen symbolicznych na wybranych zagadnieniach.

1.2. Pasek narzedzi podstawowych

Pasek narzedzi podstawowy zawiera przyciski, z ktérych wiele ma znane znaczenie.
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Oprdcz nich znajduja sig tutaj przyciski (w ramce) umozliwiajace:
- wyréwnanie regionow do gornej krawedzi,
- wyréwnanie regionéw do lewej krawedzi,
- wstawienie funkcji standardowe;j,
- wstawienie jednostek miar wielkosci fizycznych,
- wykonanie przeliczenia wyrazenia.

1.3. Pasek narzedzi formatujacych

Pasek narzedzi formatujacych jest znany z innych programéw, np. edytoréw tekstu i nie wymaga
komentarza.
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1.4. Pasek operatoréow matematycznych

Pasek operator6w matematycznych jest paskiem najczgSciej uzywanym w czasie pracy
z Mathcadem.

Math ]
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Zawiera on przyciski, po kliknigciu ktérych pojawiaja si¢ nastgpujace palety:
- paletg kalkulatora (calculator toolbar),
- paletg wykresow (graph toolbar),
- paletg dziatan wektorowych i macierzowych (vector i matrix toolbar),
- paletg obliczen (evaluation toolbar),
- paletg rachunku catkowego, rézniczkowego (calculus toolbar),
- paletg wyrazen logicznych (boolean toolbar),
- paletg programowani (programming toolbar),

palete liter greckich (greek symbol toolbar),

paletg dziatan symbolicznych (symbolic keyword toolbar).
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Rozwinigcie paska operator6w matematycznych przedstawiono ponize;j:
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Korzystanie z palet ulatwia pracg nad dokumentem bez konieczno$ci zapamigtywania skrotéw
klawiaturowych. Paski narzedzi mozna wilaczyé/wylaczy¢ z sekwencji polecen menu View=>Toolbars.
Najechanie kursorem nad wybrany przycisk spowoduje wy$wietlenie jego nazwy i skrétu klawiaturowego,
za$ wcisnigeie przycisku spowoduje jego wstawienie do obszaru dokumentu w miejscu punktu stawiania.
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1.5. Przestrzen robocza

Indefinte Integral Chi+l

Przestrzen robocza zajmuje najwigksza czg¢$¢ okna i jest miejscem, w ktorym uzytkownik moze:
wprowadza¢ wyrazenia matematyczne, formuty i réwnania,

przeprowadzac obliczenia,

tworzy¢ wykresy i wstawiac obiekty graficzne,
wprowadza¢ tekst.

W zwiazku z tym przestrzen robocza jest zbiorem regionéw:
matematycznych,
graficznych,
tekstowych
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Rozwigzanie réwnania nieliniowego:

MNurneryczne rozwigzanie rdwnania gix)=0 z wykorzystaniem funkcji root,
root{g(x),x)

glx = 4-x2 -x-12
x=3 - wartose poczatkowa

root(glx) % = 1862 x=-3-20.3

Pordwnanie otrzymanego wyniku
z j&j graficzna reprezentacjs;
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Regiony w obszarze dokumentu moga by¢ umieszczane w dowolnym miejscu. Przestrzen robocza widoczna
na ekranie jest gotowa do wydruku.

1.6. Pasek stanu

Pasek stanu, podobnie jak w wigkszosci programéw znajduje sig pod przestrzenia robocza i zawiera m.in.
nastgpujace informacje:

- numer aktualnej strony dokumentu,

- tryb obliczen,

- informacje o przeprowadzanych operacjach itp.

duto | [Page

Display a list of functions to ingert

Pasek stanu mozna wiacza¢/wylacza¢ przez sekwencje¢ View=Status Bar.

2. Edycja dokumentu

2.1. Sposob czytania dokumentu

Program Mathcad stosuje unikalny sposéb pracy nad dokumentem. Zezwala na dowolne miejsce
wprowadzania wyrazen matematycznych, tekstu i grafiki. Jednakze aby prawidlowo wykona¢ obliczenia,
nalezy pamigtac, ze wyrazenia i instrukcje do wykonania czytane Y
w linii od lewej do prawej oraz od géry do dotu. Z tego powodu wazne jest aby wyrazenia
i funkcje miaty odpowiednie potozenie. W przypadku probleméw nalezy dokument przeformatowac,
przemieszczajac wzory i wykresy. Mozna tego dokona¢ dla pojedynczych regionéw przez jego
przeciagnigcie lub tez wyréwnywac regiony z wykorzystaniem przyciskow Align Across lub Align Down z
paska narzedzi podstawowych.
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2.2. Wprowadzanie i edycja wyrazen matematycznych

Po uruchomieniu programu obszar jest pusty. W gérnym lewym rogu znajduje si¢ kursor roboczy, ktérego
wyglad przedstawia ponizszy rysunek:
4

Potozenie kursora roboczego mozna zmieniac stosujac klawisze SPACJI i strzalek, lub tez klikajac myszka
w dowolnym miejscu przestrzeni roboczej.

Z klawiatury lub z wykorzystaniem paskéw narzgdzi mozna zacza¢ wprowadza¢ wyrazenia matematyczne,
tekst lub grafike.

W celu prze¢wiczenia prosz¢ wpisa¢ nastgpujaca sekwencjg znakow:

x/\2spacja+sin(x)+1

W trakcie wpisywania pojawia si¢ prostokat, w ktéorym zawiera si¢ wpisywane wyrazenie. Przy
wpisywanych symbolach pojawia si¢ linia edycji _| , ktéra zaznacza pojedyncze znaki jak i cale wyrazenia.
Wynikiem powinno by¢ nastgpujace wyrazenie:

x2 + sin(x) + 1

Wyrazenie mozna edytowa¢, dopisujac lub usuwajac litery, symbole i operatory przez kliknigcie w
wybranym punkcie. Zakres linii edycji zmienia¢ mozna uzywajac klawiszy SPACJI i strzalek.

2.3. Wprowadzanie i edycja tekstu

Wprowadzanie tekstu do dokumentu odbywa si¢ przez wskazanie z wykorzystaniem kursora roboczego
miejsca wstawienia i naci$nigcie klawisza cudzystowu (7 ) lub wybraniu sekwencji Insert=>Text Region.
w obszarze roboczym pojawi sig czarny prostokat
z pionowa kreska i mozna rozpocza¢ wprowadzanie tekstu. Po zakonczeniu za pomoca strzatki opuszczamy
region tekstu. Ponizsza ilustracja przedstawia etapy wprowadzania tekstu.
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Aby wprowadzi¢ tekst do istniejacego regionu nalezy klikna¢ pomigdzy dwoma znakami
w regionie; pole tekstu otacza region, a wszelkie zmiany wprowadzane sa przez punkt wstawiania.
Wprowadzanie tekstu i operacje na nim w regionie tekstu odbywaja si¢ w sposdb analogiczny do operacji
wykonywanych w edytorach tekstu np. MS Word.
Aby ustali¢ statg szerokos$¢ regionu tekstu nalezy:

1. Wpisywac¢ tekst az do osiagnigcia zadanej szeroko$ci wiersza,

2. Wpisa¢ spacjg i nacisnaé¢ klawisze [CTRL] [4].
Wszystkie kolejne wiersze beda miaty stala szerokos¢. W trakcie uzupehiania lub edycji tekstu bgdzie on
tak famany, aby utrzymacé szeroko$¢é wiersza, w ktérym wcisnigto

[CTRL] [«].

Tao jest przykiadowey tekst
tarnany wten sposdb aby
utrzyrmad staty
szerokoss wiersza.

Aby wprowadzi¢ litery greckie w regon tekstu nalezy zastosowac jedna z ponizszych metod:
- wybra¢ zadana literg z paska Greek,

- wpisa¢ tacifiski odpowiednik litery greckiej, a nastgpnie weisna¢ [CTRL] [G].

W regionach tekstu mozna wprowadza¢ wzory i wyrazenia matematyczne, ktére sa pomijane w procesie
obliczeniowym.

2.4. Zarzadzanie regionami

W przypadku pracy nad bardziej ztozonymi dokumentami regiony tekstowe, matematyczne i grafiki moga
nachodzi¢ na siebie, tworzac nieczytelny zbior regionéw. W celu identyfikacji regionéw nalezy wybrac
sekwencje View=Regions. Tto obszaru roboczego zmieni kolor, za$ regiony beda koloru biatego. W
przypadku stwierdzenia pokrywania si¢ regionéw mozna pojedynczo rozsunaé je lub tez wykorzystaé
sekwencj¢ Format=Separate Regions. Regiony zostana rozsunigte.

3. Podstawowe dziatania w Mathcadzie

3.1 Statle wbudowane

Program Mathcad posiada dwa rodzaje statych wbudowanych: matematyczne i systemowe.

Wbudowane stale matematyczne to:

Symbol Nazwa
T liczba pi
% procent
e podstawa logarytmu naturalnego
i,] liczba urojona
oo symbol nieskonczonosci

Doktadne wartosci wbudowanych stalych matematycznych wykorzystywane sa przy obliczeniach
symbolicznych.

Wbudowane state systemowe to:

Nazwa Wartos¢ domyslna
TOL 0.001
CTOL 0.001
ORIGIN 0
PRNPRECISION 4
PRNCOLWIDTH 8

Stata TOL okresla precyzjg obliczen catek i pochodnych oraz ma wptyw na wyniki obliczen wykonywanych
w bloku obliczeniowym i funkcji root. Stala CTOL ma wplyw na obliczenia w bloku obliczeniowym z
wigzami (nieréwno$ciami). Stata ORIGIN okre$la poczatkowy index wektoréw. Dwie ostatnie uzywane sa
przy zapisywaniu danych do pliku
z wykorzystaniem polecenia WRITEPRN.

Program zezwala na zmiang wartosci tych statych.

3.2. Nazwy zmiennych i funkcji (zalezne od wersji)

Nazwy zmiennych i funkcji moga zawiera¢ dowolne znaki z ponizszej listy:
- duze i mate litery,
- cyfryod0do9,
- znak podkreslenia,
- symbol akcentu,
- znak procentu,
- litery greckie.
Nazwy zmiennych i funkcji nie moga zawiera¢ (zaleznie od wersji):
- przerw (spacji),
- cyfry, podkreslenia, znaku akcentu i procentu na poczatku.
Zaleca sig nie uzywa¢ w nazwach zmiennych i funkcji nazw wbudowanych w program statych, jednostek i
funkcji.
Przyktady poprawnych nazw:
alfa_8% , o B3 , y100



3.3. Zmienne proste i zakresowe

Definicja zmiennej okresla warto$¢ zmiennej, wazng gdziekolwiek ponizej linii definicji.
W celu przypisania warto$ci pewnej zmiennej a, wpisujemy z klawiatury nastgpujacy ciag znakéw: a:. W
wyniku tego w obszarze roboczym pojawi si¢ prostokat zawierajacy definiowana zmienna oraz znak

przypisania:

W czarne pole wpisujemy liczbg, co spowoduje utworzenie zmiennej lokalne;j.
a=10

Istnieje mozliwo$¢ definiowania zmiennych globalnych, stosujac globalny znak przypisania. W tym celu
nalezy wpisa¢ nastgpujacy ciag znakéw: a~10, co da nastgpujacy rezultat:

a=1(
Zmienne definiowane w spos6b przedstawiony powyzej sa zmiennymi prostymi.
Drugim rodzajem zmiennych sa zmienne zakresowe (iteracyjne), ktore stuza do tablicowania funkcji oraz
wykonywania obliczen iteracyjnych. W celu zdefiniowania takiej zmiennej
z klawiatury wprowadzamy nastgpujaca sekwencj¢ znakow: a:0;10. Na ekranie pojawi si¢ definicja

a:=0.1(
Zmienna zdefiniowana w ten sposob na kolejne wartosci z przedzialu 0 do 10 ze skokiem 1, czyli
0,1,2...,9,10. W celu zmiany skoku nalezy po pierwszej wartosci zmiennej podac¢ kolejna, oddzielona
przecinkiem np. a:0,0.1;10 co daje nastgpujaca definicjg

a:=0,0.1.. 1C

Oznacza one, ze zmienna a przybiera kolejne warto$ci ze skokiem 0.1.

Definiujac zmienng mozna stosowa¢ w nazwach indeksy dolne. Nalezy jednak uwaza¢, aby wprowadzi¢ w
definicji indeks opisowy, a nie wektorowy (wyglad obu jest taki sam, znaczenie zas r6zne). Indeks opisowy
wprowadza si¢ w nastgpujaca sekwencja znakow: a.1:10, za$ rezultatem jest

ap=1C
Definicja zmiennej moze zawiera¢ prostq nazwe zmiennej, nazwe zmiennej indeksowanej, macierz, nazwe
funkcji, funkcje, zmienng 7 indeksem gornym.

3.4. Podstawowe operatory arytmetyczne

Operatory arytmetyczne moga by¢ wprowadzane z klawiatury, badZ tez przez wcisnigcie wlasciwego
symbolu na palecie kalkulatora. Do przeprowadzenia prostych dziatan arytmetycznych Mathcad uzywa:

-+ (dodawanie),

- — (odejmowanie),

- * (mnozenie),

-/ (dzielenie),

- N (potggowanie),

- ! (silnia),

-\ (pierwiastkowanie).
Operatoréw tych mozna uzywaé¢ zaréwno do przeprowadzania prostych obliczen, jak i przy definiowaniu
funkcji i wyrazen.

3.5. Definiowanie funkcji uzytkownika

Mathcad umozliwia definiowanie funkcji uzytkownika. Warto$¢ funkcji zalezy od warto$ci argumentow
funkcji. Definicja funkcji przebiega podobnie do definicji zmiennej, z ta réznica, ze nazwa zawiera listg
argumentow, np.:

1 2
E(m,v) .:;m»v

Po zdefiniowaniu funkcji moze by¢ ona uzyta w dowolnym miejscu ponizej linii definicji.
10

3.6. Obliczenia z wykorzystaniem jednostek i wymiaréw

Mathcad umozliwia przeprowadzanie obliczen z wykorzystaniem jednostek. Standardowo ustawiony jest
system obstugi jednostek z uktadu SI. Program rozpoznaje wigkszo$¢ skrétéw jednostek. Przy obliczeniach
z jednostkami, o kazdym wprowadzeniu wyrazenia sprawdzana jest jego zgodno$¢ wymiarowa. W
przypadku niezgodno$ci wymiarowej pojawi si¢ komunikat o btedzie.
Jednostki dodaje si¢ przez wpisaniu znaku mnozenia pomigdzy liczba a jednostka, np.: m:10¥kg, co daje
nastgpujacy wynik:

m:= 10kg
Od miejsca definicji zmienna m bedzie miata przypisang jednostkg masy.
Przyktad obliczen z wykorzystaniem jednostek:

mass = 10kg
asm 12
2
sec
F = massa
F=10N

Mathcad umozliwia konwersj¢ jednostek, skalowanie wynikow oraz definiowanie wtasnych jednostek w
przeliczeniu na jednostki istniejace.

3.7. Formatowanie wynikéw

Uzytkownik moze wptywa¢ na wySwietlane wyniki przeprowadzonych obliczen. Mozliwa jest zmiana
formatu wyniku dla catego dokumentu (format globalny) jak i dla pojedynczego wyniku (format lokalny).
Ustawien dokonuje si¢ wybierajac sekwencj¢ Format=>Result.

Result Format x|

Number Format | Diigplay Dptmnsl UnitD\spIayl To\elancel

Mumber of decimal places |3 3:

Farmat

Decimal
Scientific I Show tralling zeros
Enginesring
Fraction

[~ Show exponents in enginesring
format

Exponential threshold 3 3:

oK I Anuluj Set az Delaultl Pamoc I

3.8. Kontrola przebiegu obliczen

Po uruchomieniu programu Mathcad ustawia si¢ w tryb automatycznego obliczania wyrazef, co oznacza, ze
kazda zmiana réwnania lub wyrazenia automatycznie jest przeliczana
i podawany jest aktualny rezultat. Aktualny tryb pracy mozna odczytaé z paska stanu.

Tryb automatyczny mozna wylaczy¢ wybierajac sekwencje Tools=Calculate=>Automatic Calculation.
Gdy tryb automatyczny jest wylaczony, Mathcad zaprzestaje biezacego obliczania wyrazen. Aby przeliczy¢
dokument nalezy wcisna¢ klawisz CTRL+F9, co spowoduje aktualizacj¢ dokumentu.

Czasami zachodzi potrzeba wytaczenia niektorych réwnan z obliczen. W tym celu nalezy klikna¢ na
réwnaniu prawym przyciskiem myszy i wskaza¢ Disable Evaluation.
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E(m, ") = %-m]vz

Wiew Multiplication As

& cut
Copy

E Baste

Properties...

Optimize

Przy wylaczonym réwnaniu w gérnym prawym rogu pojawia si¢ czarny prostokat. Ponowne wtaczenie
réwnania do obliczen odbywa sig¢ w analogiczny sposob, tym razem wybierajac Enable Evaluation.
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